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Chapter 9  Right of Way Mapping CADD  
CADD Production Criteria Handbook 

9.1 Right of Way Mapping CADD Standards 
 

9.1.1 File Naming Convention 
 
FDOT utilizes standard naming conventions for all of its files. Some of the automation implemented 
in various tools provided by FDOT depends on naming conventions being met. More importantly, the 
naming convention confers information to the downstream customer of the data.  
 

9.1.2 Standard File Names 
 

Standard file names should follow this format:  AABBBB##.ext 
Where AA = abbreviated group description, BBBB = Sheet type, ## =Sequence number. 
 
NOTE: Please see CPCH Chapter 4 for more information for file extensions.  
 
The following table defines the Right of Way Mapping File Name Standards in regards to FDOT Projects 
with the understanding that each file name will include sequence numbering.  The standard map naming 
convention shall be a maximum of an eight character prefix and a .dgn suffix.  The prefix shall be a two 
letter group name with a four letter file name and two-digits for the sheet number 

 (Note: F.P. = Financial Project Number).   

Example:  RWDETL01.DGN 
 RW ...........  Right of Way Mapping Group 
 ......... DETL         Detail Sheet File 

01 Sheet Number 1 

File Name Descriptions Critical 
File 

CS(F.P. No.) Control Survey Master Design File (Enter 7 digit No.)  
CSCOVR.DGN Control Survey Cover Sheet X 
CSDETL.DGN Control Survey Detail Sheet X 
CSKEYM.DGN Control Survey Key Map Sheet X 
MM(F.P. No.) Maintenance Map Master Design File (Enter 7 digit No.)  
MMCOVR.DGN Maintenance Map Cover Sheet X 
MMDETL.DGN Maintenance Map Detail Sheet X 
MMKEYM.DGN Maintenance Map Key Map Sheet X 
RW(F.P. No.) R/W Master Detail Design File (Enter 7 digit No.)  
RWCOVR.DGN R/W Cover Sheet X 
RWDETL.DGN R/W Detail Sheet X 
RWFACS.DGN R/W Cover Sheet FA Project X 
RWKEYM.DGN R/W Key Map Sheet X 
RWPNCTAB.DGN R/W Project Network Control Tabulation Sheet X 
RWPR.DGN R/W Parcel Sketch Sheet (11”x17” Landscape) X 
RWPS.DGN R/W Parcel Sketch Sheet (8.5”x11” Portrait) X 
RWSPS.DGN R/W Specific Purpose Survey Sheet X 
RWTAB.DGN R/W Tabulation Sheet X 
RWTABENG.PLT R/W Tabulation Sheet Data (ENGLISH) X 
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9.1.3 Seed File Settings 
 

• English Seed File Settings (Non-Survey Inch) 
 
English Working Units for MicroStation V8 are set to “US Survey Foot” standard (1 Survey Foot = 
1200/3937m >> 0.30480061).  The seed file for Right of Way Mapping is “RWSEED2D.DGN”. The 
design file global origin shall be center of the design plane 7400, 7400. 
 
 

 
  

 
 
• Advanced Working Unit Settings 

 
The Edit button opens the Advanced Unit 
Settings dialog box. These settings define two 
items. The first establishes the size of a grid 
(similar to the design plane in MicroStation/J) 
that overlays the drawing area. This grid is 
used for backward compatibility with older 
versions of MicroStation. The Advanced Unit 
Settings should appear as shown here. 
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9.1.4 Standard Text Fonts 
 
MicroStation font libraries are resource files and typically have the extension ".rsc." They contain 
essentially the same information as font libraries from earlier versions, but in a different format.  By 
carefully assigning the first 128 of the 256 available font numbers in a font library, backward compatibility 
is maintained with previous versions of MicroStation.  The font library, "font.rsc," contains all of the 
traditional MicroStation fonts in the "fontlib" font library supplied with previous versions. 

 
Font 58 is a vertical font that “mimics” the “Leroy” font style with an emphasis on even spaced letters that 
was created exclusively for Right of Way Mapping. This font is located in the ZDOTFONT.RSC resource 
file. 

• Key Strokes for Font 58 
 
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
A B C D E F G H I J K L M N O P Q R S T U V W X Y Z
A b c d e f g h i j k l m n o p q r s t u v w x y z
A b c d e f g h i j k l m n o p q r s t u v w x y z
~ ! @ # $ % ^ & * ( ) _ + { } | : “ < > ?    
± Δ @ # $ % ° & * ( ) _ + m

2 : “ < > ?    
` 1 2 3 4 5 6 7 8 9 0 - = [ ] \ ; ‘ , . /    

1 2 3 4 5 6 7 8 9 0 - = [ ] \ ; ‘ , . /    
1/ 
2 

1/
4 

3/ 
4 

1/
8 

3/
8 

5/
8 

½ ¼ ¾ ⅛ ⅜ ⅝ 
 
NOTE: There is a setting within MicroStation that provides the user with a graphical representation of the 
above font keystrokes for use with the place text application. To activate this setting in MicroStation go to 
Workspace/Preferences, SELECT Category = Text, under the Text Editor Style drop down SELECT 
“WYSIWYG” and Select OK. Save these Settings. Please also note that text in Cells will not be editable 
when using WYSIWYG. 
 

9.1.5 Standard Text Size 
 
The following tables of text sizes are to be used as a guide for the recommended text sizes for all right of 
way mapping projects at a given scale.  Readability of text data should be considered as priority; 
however no text should be smaller than 3.2’ on a 1” = 40’ scale (0.08” actual plotted size). 
 

• Recommended Base Text Sizes for (English) R/W Mapping  
D-SIZE (24”x36”) 

SCALE RECOMMENDED TEXT SIZES 
1” = 5’ 0.5’ 
1” = 10’ 1.0’ 
1” = 20’ 2.0’ 
1” = 30’ 3.0’ 
1” = 40’ 4.0’ 
1” = 50’ 5.0’ 
1” = 100’ 10.0’ 
1” = 200’ 20.0’ 
1” = 400’ 40.0’ 

Key Stroke 
Result 
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9.1.6 Line Styles 
 
Line style is part of the symbology of an element, for example, whether a line is solid, continuous dashes, 
dots and dashes, and so on.  In plotting, a line style is an index in the range 0 to 7 that designates a 
particular sequence of pen up/down pairs to be used when drawing or plotting a graphic element.  Each 
element has its own line style.  See below for MicroStation standard line styles. 
 

 
• Custom Line Styles 

 
MicroStation® provides for the creation of “Custom Line Styles”. Custom Line Styles have the same 
characteristics as standard MicroStation line codes and can be set as the active line style using “LC=” key 
in. For English units, “RWLINENG.RSC” was created at a 1:1 scale. Standard MicroStation line styles are 
based on output device coordinates, and therefore are not truly WYSIWYG, as are custom line styles, see 
above. It is recommended that you use custom line styles instead of standard line styles with patterned 
lines. When using Right of Way Mapping custom line styles with MicroStation it is important to set the 
correct active custom line style scale. For example: to place an English custom line styles simply set the 
scale the same as the drawing scale.  
 
Only FDOT resource ".RSC" files should be used.  
 
To set custom line style scale:   
 
Select “Line Styles>Custom” from the “Element” menu. 
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• Right of Way Mapping Custom Line Styles 
English custom line styles are created at a scale of 1” = 1’ 

 
NOTE:  Symbols in tables are not displayed at their required weights/thickness. 

 

NAME SYMBOL 

ANGLE – Angle Delineator  
ARROW2 – R/W Width  

ARROWPOINT  
ARROWTIE  

CLIMIT - City Limit 
 

CLIMIT2 – City Limit(Hash Only)  

COLINE – County Line  

EECL – Existing Easement Centerline 

EXLA – Existing L/A RW  

EXRW – Existing State Road R/W  

GRTL  -  Grant Line  

LA - Proposed L/A RW 
 

LEADERLT – Leader Left 
 

LEADERRT – Leader Right 
 

LICENSE – License  
LOC - Limits of Construction  

NONVH - Non-Vehicular Access Line 
 

NSPF - Nat./State Park/Forest  
 

NSPF2 – Nat./State Park/Forest  
(Hash Only)  

PESMT - Perpetual Ease. 

QSEC - ¼ Section Line 

RR - Railroad  

SECLIN - Section Line  
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NAME SYMBOL 

STL - State Line  

SUBDIV – Subdivision Arrow  

SUBDIV2 – Arrows2  

SUBDIV2LT – Arrows 2 LT. 

SUBDIV2LTOnly – Arrows 2 LT.  

SUBDIV2RT – Arrows 2 RT. 

SUBDIV2RTOnly – Arrows 2 RT. Only 

SUBDIVLT  

SUBDIVRT  

TEMPE – Temporary Easement 

TIITF – Murphy Reservation Line  

TWPRGE – Township/Range 

WaterMapBoundary 
 

 
 

9.1.7 R/W Mapping Cell Library  
Cells are created in cell library ROW.CEL At 1” = 1’ 

 
======================================================= 
NOTE:  RW Cells must be placed with the True Scale toggle “ON”. 

======================================================= 
 

• CELL TABLE 
NOTE: Cells in tables are not displayed at their required weights/thickness. See Symbology Index for Cell symbology. 

 
ELEMENT TYPE SYMBOL 

 
Macro 

ARROW TERMINATOR LEFT 
(Place on ByLevel of Text Element 

Relative Toggle “ON”) 
C = ARRWLG  

 

Place 
Delineator 

ARROW TERMINATOR 
RIGHT 

(Place on ByLevel of Text Element 
Relative Toggle “ON”) 

C = ARRWRG  
 

Place 
Delineator 

LINE TERMINATOR@POINT 
G = Graphic type cell 

 
C =ARRLT 

Place 
Delineator 

LINE TERMINATOR@POINT 
G = Graphic type cell C =ARRRT Place 

Delineator 
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ELEMENT TYPE SYMBOL 

 
Macro 

BAR SCALE 1” = 20’ C = BS20 
 

Place Bar 
Scale 

BAR SCALE 1” = 30’ C = BS30 
 

Place Bar 
Scale 

BAR SCALE 1” = 40’ C = BS40 
 

Place Bar 
Scale 

BAR SCALE 1” = 50’ C = BS50 
 

Place Bar 
Scale 

BAR SCALE 1” = 100’ C = BS100 
 

Place Bar 
Scale 

BAR SCALE 1” = 200’ C = BS200 
 

Place Bar 
Scale 

BAR SCALE 1” = 400’ C = BS400 
 

Place Bar 
Scale 

BASELINE CURVE DATA 
BOX 

(Used with Geopak Table 
Tutorial) 

C = BLBOX 
 

 

 
BASELINE SYMBOL C = BL  

CENTERLINE SYMBOL C = CL  

CONCRETE MONUMENT 
OPEN C = MONSQ  

CONCRETE MONUMENT 
SOLID C = MONSQS  

CONCRETE  R/W 
MONUMENT 

(R/W MONUMENTATION  MAP) 
C = MON 

 
 

 
COORDINATE DATA BOX 
(Used with Geopak Table 

Tutorial) 
C = COORD  

CURVE DATA BOX 
(Used with Geopak Table 

Tutorial) 
C = CURBOX 

 
 

 

CURVE DATA (English) 
(Used with Geopak Table 

Tutorial) 
 

C = CDATA  
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ELEMENT TYPE SYMBOL 

 
Macro 

NORTH ARROW C = NOARR   

 
PARCEL BUBBLE 100 C = PB100 

 
 

 

 
PARCEL BUBBLE 700 C = PB700 

 
 

 

 
PARCEL BUBBLE 800 C = PB800 

 
 

 

 
PARCEL BUBBLE 900 C = PB900 

 
 

 

 
PERMANENT R/W 

MONUMENT 
(R/W MONUMENTATION  MAP) 

C = PRWM  

PROPERTY LINE HOOK 
 

C= PLHOOK 
 

 
  

PROPERTY LINE HOOK 
 

C= PLHTOP 
 

 
 

 

PROPERTY LINE HOOK C =PLHBOT 
 

 

PROPERTY LINE SYMBOL C = PL  

ROD MONUMENT OPEN C = MONRD  

ROD MONUMENT SOLID C = MONRDS  

SEGMENTED CURVE 
CHORD DIST./BEARING 
(Used with Geopak Table 

Tutorial) 
C = SEGCUR  

 
SPRING LINE  (Place on 

Symbology of Assoc. Element) 
C=SPRING Place 

SpringLine 
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9.1.8 Standard Symbology Tables 
 
Refer to the Symbology tables below for the listing of right of way elements and their symbologies. The 
list of elements shown may not contain all of the elements that appear within a right of way map, as this 
list would be extensive.  The elements shown are those that are required for specific types of right of way 
maps and which may appear within all of the design file types. 
 
When other files are referenced the element symbology of those files will be adhered to.  If elements that 
are not required of a file are placed within that file, the element symbology of the file they normally reside 
in will be adhered to.  All R/W level symbologies are created as MicroStation V8 ByLevel elements. 
 
IMPORTANT: Readability of text data should be considered as priority. 
 

Level Name 

Le
ve

l N
o.

 

Level Description 

B
yL

ev
el

 
C

ol
or

 

ByLevel  
Style 

B
yL

ev
el

  
W

ei
gh

t 

BaselineCurveData 1500 Cell:Baseline Curve Data 0 0 2 

BaselineFlagLT 1501 
Annotation:Begin End Baseline Flag 
Left 0 LEADERLT 2 

BaselineFlagRT 1502 
Annotation:Begin End Baseline Flag 
Right 0 LEADERRT 2 

BaselineLeaderWt0 1503 
Annotation:Leader:Baseline Survey 
(weight = 0) 0 ArrowPoint 0 

BaselineLeaderWt1 1504 
Annotation:Leader:Baseline Survey 
(weight = 1) 0 ArrowPoint 1 

BaselineLeaderWt2 1505 
Annotation:Leader:Baseline Survey 
(weight = 2) 0 ArrowPoint 2 

BaselineSideStreet 1506 Baseline:Baseline Side Street 0 0 0 

BaselineStaTie 1507 
Annotation:Station Tie:Baseline 
Station Tie 0 ArrowTie 0 

BaselineSurvey 1508 Baseline:Baseline Survey 0 0 2 

BaselineTangentLine 1509 
Miscellaneous:Baseline Curve 
Tangent (PC‐PI‐PT) 0 2 0 

BaselineTextWt0 1510 
Annotation:Text:Baseline (weight = 
0) 0 0 0 

BaselineTextWt1 1511 
Annotation:Text:Baseline (weight = 
1) 0 0 1 

BaselineTextWt2 1512 Annotation:Text:Baseline (weight = 
2) 0 0 2 

BuildingLeader 1513 Annotation:Leader:Building 0 ArrowPoint 0 

BuildingStaTie 1514 Annotation:Station Tie:Building 0 ArrowTie 0 

BuildingText 1515 Annotation:Text:Buildings 0 0 0 

ClipBorder 1516 Cell:Miscellaneous:R/W Clip Border 4 2 0 

ClipBorderLine 1517 Cell:Miscellaneous:R/W Clip Border 4 0 4 

ClipBorderOutside 1518 Cell:Miscellaneous:R/W Clip Border 3 0 0 

Closing‐SameLine 1519 Miscellaneous:Closing Line, Same  0 ArrowTie 0 
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Level Name 

Le
ve

l N
o.

 

Level Description 

B
yL

ev
el

 
C

ol
or

 

ByLevel  
Style 

B
yL

ev
el

  
W

ei
gh

t 

Point, or Same Line 

Closing‐SameLineText 1520 
Miscellaneous:Text:Closing Line, 
Same Point, or Same Line 0 0 0 

ConstLimits 1521 Proposed:Limits of Construction Line 3 LOC 0 

ConstLimitsLeader 1522 Annotation:Leader:Limits of 
Construction (Proposed) 3 ArrowPoint 0 

ConstLimitsStaTie 1523 
Annotation:Station Tie:Limits of 
Construction (Proposed) 3 ArrowTie 0 

ConstLimitsText 1524 
Annotation:Text: Limits of 
Construction (Proposed) 3 0 0 

CoordPtText 1525 
Annotation:Text:Miscellaneous:Coor
dinate Geometry Points 4 0 0 

DataBoxWt0 1526 Cell:Miscellaneous:Data Table Wt0 
For Text and Linear Elements 0 0 0 

DataBoxWt1 1527 
Cell:Miscellaneous:Data Table Wt1 
For Text and Linear Elements 0 0 1 

DataBoxWt2 1528 
Cell:Miscellaneous:Data Table Wt2 
For Text and Linear Elements 0 0 2 

DataBoxWt3 1529 
Cell:Miscellaneous:Data Table Wt3 
For Text and Linear Elements 0 0 3 

DataBoxWt4 1530 
Cell:Miscellaneous:Data Table Wt4 
For Text and Linear Elements 0 0 4 

DetailBorder 1531 
Miscellaneous: Border for Mapping 
Detail 0 3 3 

EaseLine_ep 1532 Easement:Easement Line (Existing) 1 2 0 

EaseLineLeader_ep 1533 
Annotation:Leader:Easement 
(Existing) 1 ArrowPoint 0 

EaseLineStaTie_ep 1534 
Annotation:Station Tie:Easement 
(Existing) 1 ArrowTie 0 

EaseLineText_ep 1535 
Annotation:Text:Easement Lines 
(Existing) 1 0 0 

EaseLineWidthArrow_ep 1536 Annotation:Arrow:Easement Width 
(Existing) 1 ARROW2 0 

EaseLineCenterline_ep 1537 
Baseline:Centerline:Easement 
(Existing) 1 EECL 0 

EaseLicLine 1538 Easement:License (Proposed) 0 LICENSE 1 

EaseLicLeader 1539 
Annotation:Leader:License 
(Proposed) 0 ArrowPoint 0 

EaseLicStaTie 1540 
Annotation:Station Tie:License 
(Proposed) 0 ArrowTie 0 

EaseLicText 1541 
Annotation:Text:Easement Lines, 
License (Proposed) 0 0 1 

EaseLicWidthArrow 1542 Annotation:Arrow:License Width  0 ARROW2 0 
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Level Name 

Le
ve

l N
o.

 

Level Description 

B
yL

ev
el

 
C

ol
or

 

ByLevel  
Style 

B
yL

ev
el

  
W

ei
gh

t 

(Proposed) 

EasePerpLine 1543 
Easement:Perpetual Easement Line 
(Proposed) 4 PESMT 2 

EasePerpLeader 1544 
Annotation:Leader:Easement 
Perpetual (Proposed) 4 ArrowPoint 1 

EasePerpStaTie 1545 
Annotation:Station Tie:Easement 
Perpetual (Proposed) 4 ArrowTie 0 

EasePerpText 1546 
Annotation:Text:Easement Lines, 
Perpetual (Proposed) 4 0 1 

EasePerpWidthArrow 1547 
Annotation:Arrow:Easement 
Perpetual Width (Proposed) 4 ARROW2 0 

EaseTempLine 1548 
Easement:Temporary Easement Line 
(Proposed) 6 TEMPE 1 

EaseTempLeader 1549 
Annotation:Leader:Easement 
Temporary (Proposed) 6 ArrowPoint 1 

EaseTempStaTie 1550 
Annotation:Station Tie:Easement 
Temporary (Proposed) 6 ArrowTie 0 

EaseTempText 1551 
Annotation:Text:Easement Lines, 
Temporary (Proposed) 6 0 1 

EaseTempWidthArrow 1552 
Annotation:Arrow:Easement 
Temporary Width (Proposed) 6 ARROW2 0 

GenNotesLeader 1553 
Annotation:Leader:Miscellaneous:Ge
neral Notes 0 ArrowPoint 2 

GenNotesText 1554 
Annotation:Miscellaneous:Text: 
General Notes 0 0 2 

GovCityLimitHLine_ep 1555 
Government:City Limit Line (Hash 
Only) 3 Climit2 0 

GovCityLimitLine_ep 1556 Government:City Limit Line 3 CLIMIT 0 

GovCountyLine_ep 1557 Government:County Line 3 COLINE 3 

GovGrantLine_ep 1558 Government:Grant Line 3 GRTL 2 

GovGreenLeaderWt0_ep 1559 
Annotation:Leader:Government 
(color = green)(weight = 0) 2 ArrowPoint 0 

GovGreenLeaderWt2_ep 1560 
Annotation:Leader:Government 
(color = green)(weight = 2) 2 ArrowPoint 2 

GovGreenStaTie_ep 1561 
Annotation:Station Tie:Government 
(color = green) 2 ArrowTie 0 

GovGreenTextWt0_ep 1562 
Annotation:Government Text Green 
Weight of 0 2 0 0 

GovGreenTextWt2_ep 1563 
Annotation:Government Text Green 
Weight of 2 2 0 2 

GovLotLine_ep 1564 Government:Lot Line 3 0 1 

GovMeanderLine_ep 1565 Government:Meander  Line 3 3 1 
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Level Name 

Le
ve

l N
o.

 

Level Description 

B
yL

ev
el

 
C

ol
or

 

ByLevel  
Style 

B
yL

ev
el

  
W

ei
gh

t 

GovParkHLine_ep 1566 
Government:National or State Park 
or Forest Line (Hash Only) 2 NSPF2 0 

GovParkLine_ep 1567 
Government:National or State Park 
or Forest Line 2 NSPF 0 

GovQtrQtrLine_ep 1568 
Government:Quarter / Quarter 
Section Line 3 QSEC 0 

GovQuarterLine_ep 1569 Government:Quarter Section Line 3 QSEC 1 

GovRedLeaderWt0_ep 1570 
Annotation:Leader:Government 
(color = red)(weight = 0) 3 ArrowPoint 0 

GovRedLeaderWt2_ep 1571 
Annotation:Leader:Government 
(color = red)(weight = 2) 3 ArrowPoint 2 

GovRedStaTie_ep 1572 
Annotation:Station Tie:Government 
(color = red) 3 ArrowTie 0 

GovRedTextWt0_ep 1573 
Annotation:Government Text Red 
Weight of 0 3 0 0 

GovRedTextWt2_ep 1574 
Annotation:Government Text Red 
Weight of 2 3 0 2 

GovSectionLine_ep 1575 Government:Section Line 3 SECLIN 2 

GovStateLine_ep 1576 Government:State Line 2 STL 3 

GovTwpRgeLine_ep 1577 
Government:Township and Range 
Government Survey Line 2 TWPRGE 3 

LARWLine 1578 
Proposed:Limited Access Right of 
Way Line 4 LA 3 

LARWLine_ep 1579 Existing:Limited Access Right of Way 
Line 7 EXLA 0 

MaintLeader 1580 Annotation:Leader:Maintenance 4 ArrowPoint 2 

MaintLine 1581 Proposed:Maintenance Line 4 0 4 

MaintStaTie 1582 Annotation:Station Tie:Maintenance 4 ArrowTie 0 

MaintText 1583 Annotation:Text: Maintenance 4 0 2 

MaintWidthArrow 1584 
Annotation:Arrow:Maintenance 
Width (Proposed) 4 ARROW2 0 

MHWL_TIITF_Leader 1585 
Annotation:Leader:TIITF:Mean High 
Water Lines or Ordinary High Water 
Lines 

7 ArrowPoint 2 

MHWL_TIITF_StaTie 1587 
Annotation:Station Tie:TIITF:Safe 
Upland Elevation Lines or 
Jurisdictional Lines 

7 ArrowTie 2 

MHWL_TIITF_Text 1588 
Annotation:Text:TIITF:Mean High 
Water LInes or Ordinary High Water 
Lines 

7 0 2 

MHWL_TIITF_WidthArrow 1589 
Annotation:Arrow:TIITF:Mean High 
Water LInes or Ordinary High Water 

7 ARROW2 2 
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Level Name 

Le
ve

l N
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Level Description 
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ByLevel  
Style 

B
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W
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Lines 

MonConcOpen 1590 Cell:Monument,Concrete Open 4 0 1 

MonConcSolid 1591 Cell:Monument, Concrete Solid 4 0 1 

MonConRW 1592 Cell:Monument, Concrete RW 4 0 2 

MonLeader 1593 
Annotation:Leader:Found / Set 
Monuments (Not Government 
Corners) 

4 ArrowPoint 0 

MonPermRW 1594 
Cell:Monument, RW Permanent (RW 
Survey Map) 4 0 2 

MonRodOpen 1595 Cell:Monument, Rod Open 4 0 1 

MonRodSolid 1596 Cell:Monument, Rod Solid 4 0 1 

MonStaTie 1597 
Annotation:Station Tie:Found / Set 
Monuments (Not Government 
Corners) 

4 ArrowTie 0 

MonText 1598 
Annotation:Text:Found / Set 
Monuments (Not Government 
Corners) 

4 0 0 

Murphy_TIITF_Leader 1599 
Annotation:Leader:TIITF:Murphy 
Reservations Lines 2 ArrowPoint 1 

Murphy_TIITF_Line 1600 
TIITF: Upland TIITF:Murphy 
Reservations Lines 2 TIITF 1 

Murphy_TIITF_StaTIe 1601 
Annotation:Station Tie:TIITF:Murphy 
Reservations Lines 2 ArrowTie 1 

Murphy_TIITF_Text 1602 
Annotation:Text:TIITF:Murphy 
Reservations Lines 2 0 1 

Murphy_TIITF_WidthArrow 1603 
Annotation:Arrow:TIITF:Murphy 
Reservations Lines 2 ARROW2 1 

NonVehcLeader_ep 1604 
Annotation:Leader:Non Vehicular 
Access 3 ArrowPoint 0 

NonVehcLine_ep 1605 Existing:Non‐Vehicular Access Line 3 NONVH 0 

NonVehcStaTie_ep 1606 
Annotation:Station Tie:Non Vehicular 
Access 3 ArrowTie 0 

NonVehcText_ep 1607 
Annotation:Text:Non‐Vehicular 
Access (Existing) 3 0 0 

ParcelBubble100 1608 
Cell:Miscellaneous:Right of Way 
Parcel Bubble with Leader 3 0 2 

ParcelBubble700 1609 
Cell:Miscellaneous:Temporary 
Easement Parcel Bubble with Leader 6 0 2 

ParcelBubble800 1610 
Cell:Miscellaneous:Perpetual 
Easement Parcel Bubble with Leader 4 0 2 

ParcelBubble900 1611 Cell:Miscellaneous:License Parcel  0 0 2 
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Level Name 
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Level Description 
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ByLevel  
Style 
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W
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Bubble with Leader 

PropertyLine_ep 1612 Existing:Property Line 7 0 0 

PropertyLineHook_ep 1613 
Cell:Miscellaneous:Property Line 
Hook 4 0 0 

PropertyLineLeader_ep 1614 Annotation:Leader:Property Line 
(Existing) 7 ArrowPoint 0 

PropertyLineStaTie_ep 1615 
Annotation:Station Tie:Property Line 
(Existing) 7 ArrowTie 0 

PropertyLineSymbol 1616 
Cell:Miscellaneous:Property Line 
Symbol 4 0 0 

PropertyLineText_ep 1617 
Annotation:Text:Property Line 
(Existing) 7 0 0 

RFClipPoint 1618 Cell:Miscellaneous:Point (Point Cell 
for RFCLIP Program) 4 0 10

RRBaseline 1619 Baseline:Rail Road Centerline 0 RR 0 

RRLeaderWt0 1620 
Annotation:Leader:Railroad  (weight 
= 0) 0 ArrowPoint 0 

RRLeaderWt1 1621 
Annotation:Leader:Railroad  (weight 
= 1) 0 ArrowPoint 1 

RRLeaderWt2 1622 
Annotation:Leader:Railroad (weight 
= 2) 0 ArrowPoint 2 

RRTextWt0 1623 
Annotation:Text:Railroad (weight = 
0) 0 0 0 

RRTextWt1 1624 Annotation:Text:Railroad (weight = 
1) 0 0 1 

RRTextWt2 1625 
Annotation:Text:Railroad (weight = 
2) 0 0 2 

RW_Line 1626 Proposed:Right of Way Line 4 RW 3 

RW_Line_ep 1627 Existing:RW Line 7 RW 0 

RWandLA_Leader 1628 
Annotation:Leader:R/W & L/A 
(Proposed) 3 ArrowPoint 2 

RWandLA_Leader_ep 1629 
Annotation:Leader:R/W & L/A 
(Existing) 7 ArrowPoint 0 

RWandLA_StaTie 1630 
Annotation:Station Tie:R/W & L/A 
Lines (Proposed) 3 ArrowTie 0 

RWandLA_StaTie_ep 1631 
Annotation:Station Tie:R/W & L/A 
Lines (Existing) 7 ArrowTie 0 

RWandLA_Text 1632 
Annotation:Text:R/W & L/A Lines 
Taking Lines (Proposed ) 3 0 2 

RWandLA_Text_ep 1633 
Annotation:Text:R/W & L/A Lines 
(Existing) 7 0 0 

RWandLA_WidthArrow 1634 
Annotation:Arrow:RW & LA Width 
(Proposed) 3 ARROW2 0 
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Level Name 
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Level Description 
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Style 
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RWandLA_WidthArrow_ep 1635 
Annotation:Arrow:RW & LA Width 
(Existing) 7 ARROW2 0 

ScratchElements 1636 
Scratch:None Plotting Level for Draft 
Elements, Temporary Elements, Etc. 3 0 0 

ScratchLevel1 1637 
Scratch:Level for Undefined Items ‐ 
weight of 1 0 0 1 

ScratchLevel2 1638 
Scratch:Level for Undefined Items ‐ 
weight of 2 0 0 2 

ScratchLevel3 1639 
Scratch:Level for Undefined Items ‐ 
weight of 3 0 0 3 

SegCurveData 1640 
Cell:Miscellaneous:Segmented Curve 
Data (Place on Text Symbology of 
Assoc. Element) 

0 0 0 

SideStLeaderWt1 1641 
Annotation:Leader:Side Street 
(weight = 1) 0 ArrowPoint 1 

SideStLeaderWt2 1642 Annotation:Leader:Side Street 
(weight = 2) 0 ArrowPoint 2 

SideStStaTie 1643 Annotation:Station Tie:Side Street 0 ArrowTie 0 

SideStTextWt1 1644 
Annotation:Text:Side Street Curve 
Data, Curve & Coordinate Box Text 0 0 1 

SideStTextWt2 1645 
Annotation:Text:Side Street 
Data:Stations,Names,Leader 
Lines&Circles for (PC,PT,PI,POT) 

0 0 2 

SubBlockNumberText 1646 
Cell:Miscellaneous:Subdivision:Text:
Block Number Enter Data Field 5 0 2 

SubDivDelineator 1647 
Annotation:Subdivision Delineator 
Line for Subdivision Terminator 5 0 1 

SubDivLine 1648 Existing:Subdivision Line 5 0 0 

SubDivLineText 1649 
Annotation:Text:Subdivision: Lines & 
Vacated / Original Lot Lines (Existing) 5 0 0 

SubDivNameText 1650 
Annotation:Text:Subdivision: Plat 
Name (Existing) 5 0 2 

SubDivRW_WidthArrow 1651 Annotation:Arrow:Subdivision 5 ARROW2 0 

SubDoubleArrow 1652 
Annotation:Subdivision: Boundary 
Arrows Double  <<‐‐‐‐>> 5 SUBDIV2 1 

SubLotNumberText 1653 
Annotation:Text:Subdivision: Lot 
Numbers 5 0 1 

SubSingleArrow 1654 
Annotation:Subdivision: Boundary 
Arrows <‐‐‐‐> 5 SUBDIV 1 

SubSingleLTArrow 1655 
Annotation:Subdivision: Boundary 
Arrows Single Left <‐‐‐‐ 5 SUBDIVLT 1 

SubSingleRTArrow 1656 
Annotation:Subdivision: Boundary 
Arrows Single Right ‐‐‐‐> 5 SUBDIVRT 1 
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Level Name 
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SubTwoLTArrow 1657 
Annotation:Subdivision: Boundary 
Arrows Two Left <<‐‐‐‐> 5 SUBDIV2LT 1 

SubTwoLTOnlyArrow 1658 
Annotation:Subdivision: Boundary 
Arrows Two Left Only <<‐‐‐‐ 5 SUBDIV2LTOnly 1 

SubTwoRTArrow 1659 
Annotation:Subdivision: Boundary 
Arrows Two Right <‐‐‐‐>> 5 SUBDIV2RT 1 

SubTwoRTOnlyArrow 1660 
Annotation:Subdivision: Boundary 
Arrows Two Right Only ‐‐‐‐>> 5 SUBDIV2RTOnly 1 

SubVacOrigLotLeader 1661 
Annotation:Leader:Subvivision: Lines 
& Vacated / Original Lot Lines 
(Existing) 

5 ArrowPoint 0 

SubVacOrigLotLine 1662 
Existing:Subdivision Vacated or 
Original Lot Line 5 5 0 

SubVacOrigLotStaTie 1663 
Annotation:Station Tie:Subdivision 
Vacated & Original Lot 5 ArrowTie 0 

SUEL_TIITF_Leader 1664 
Annotation:Leader:DEP:TIITF:Safe 
Upland Elevation Lines or 
Jurisdictional Lines 

2 ArrowPoint 2 

SUEL_TIITF_Line 1665 
DEP:TIITF:Safe Upland Elevation 
Lines or Jurisdictional Lines 
established by DEP methodology 

2 PESMT 3 

SUEL_TIITF_StaTie 1666 
Annotation:Station 
Tie:DEP:TIITF:Safe Upland Elevation 
Lines or Jurisdictional Lines 

2 ArrowTie 2 

           

SUEL_TIITF_Text 1667 
Annotation:Text:DEP:TIITF:Safe 
Upland Elevation Lines or 
Jurisdictional Lines 

2 0 2 

SUEL_TIITF_WidthArrow 1668 
Annotation:Arrow:DEP:TIITF:Safe 
Upland Elevation Lines or 
Jurisdictional Lines 

2 ARROW2 2 

TabOwnshpText 1669 
Annotation:Text:Miscellaneous: 
Table of Ownerships 0 0 1 

TopoText_ep 1670 
Annotation:Text:Miscellaneous: All 
Other Topograhic Element Labels 
(Reference Files) 

0 0 0 

WaterEdge_ep 1671 
Annotation:Mapping Boundary for 
Rivers, Streams, or Lakes 7 

WaterMapBoun
dary 

0 
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9.2 Right of Way FDOT Menu 
 

 
 

9.2.1 Overview 
Right of Way FDOT Menu was designed with the user in mind.  It is a package that facilitates right of 
way mapping plans preparation incorporating the R/W Mapping CADD Standards, Cell Libraries, 
Custom Line Styles and Notes etc. The FDOT Menu provided on the FDOT2008 software is a C++ 
executable program called FDOT Menu. 
 
The Standard FDOT Menu is made available by setting the MicroStation Manager Workspace to 
“FDOT2008” for English unit projects and displays upon opening a design file.   
 

 
 

The User may select from the Standard pull down option (see below) to configure the FDOT Menu bar to 
include the R/W FDOT Menu and other Discipline specific FDOT Menu’s. When selected, the FDOT 
Menu Configuration dialog (see below) displays in which the user can select the desired discipline 
menu(s). All of FDOT’s MicroStation applications have been included in the FDOT Menu’s plus some 
useful tools from MicroStation’s Vault CD. These applications are maintained within the FDOT Menu 
selections CellApps, Locks, and Actions. For detailed instructions on the use of FDOT Menu select 
Standards > FDOT Menu Getting Started. 
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9.2.2 View Levels 

 
 

This is a VBA macro that allows you to display used levels individually in a slide-show type of manner. If 
you tend to crawl up and down your levels a lot, you may find this much faster than traditional methods. 
 
 
 
 
 
 
 
 

o Levels:  Displays a list of level names that currently exist in the design file. 
 

o Restore View on Exit: When selected (on) all levels in list will be displayed when macro 
is exited. When not selected (off) the current active will be the only level displayed when 
the macro is exited.  

 
o Previous:  Moves to the level previously selected in the list. 

 
o Next: Moves to the next level in the list. 

 
o Exit:  Exits the program. 
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9.2.3 RW Hot Lists 
The R/W Mapping FDOT Menu Hot 
List dialog provides the user with 
quick access to many of the 
categories and items located on the 
FDOT Menu pull downs. The Hot List 
dialog can be activated by selecting 
Right of Way > RW Hot Lists: 

 
 

 The RW Hot Lists dialog box contains the following tab selections: 
 

o RW-Sheet-Cells - Mapping sheet cells for placement into the MicroStation design file.  
The same process is used for placement of sheet cells as described under RW-Cells 
shown previously. 
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o RW-Cells – Provides quick access to R/W Mapping cells for placement into a 
MicroStation design file.  Simply select the desired cell name and double click. The cell 
placement command will execute and the cell will be attached to the MicroStation cursor 
for placement. The Active Scale dialog (also shown) will be activated for adjustment of 
scale prior to the data point to place the cell.  
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o RW-Arrows – Provides access to all R/W Mapping Arrows, Delineators and other 
annotation applications as located on the R/W Mapping FDOT Menu. 
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o RW-Info – Provides access to a variety of R/W Mapping information such as R/W 
Mapping CADD Chapter 9 and R/W Mapping CADD Symbology 2008 which are chapters 
of the FDOT2008 CADD Production Criteria Handbook (CPCH). Also the user has 
access to Help files on R/W Mapping FDOT Menu categories.  
 
Web site access is also provided, for Engineering/CADD Systems Office(ECSO) Infonet web 
sites and ECSO  Internet web sites for quick access to important information.  When Infonet 
or Internet web sites are selected the Rowse Company FDOT Menu Browser will be actived 
within MicroStation for viewing/browsing web sites. 
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o Misc-Dialogs – Provides quick access to various MicroStation command dialogs.  
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• R/W Hot Boxes 
The R/W Mapping FDOT Menu also provides a means of quick access to Hot List dialog and browser 
windows by using Hot Box icons. After the FDOT2008 software has been installed and the Right of Way 
Mapping discipline selected from the FDOT Menu Standard>Select Configuration as shown previously, 
the FDOT Menu should appear as 
shown below with five icons located 
to the right of the menu bar.   
 
These icons provide quick access to Run PlotScale, Quick Check, R/W Hot Lists, Browser and QC 
Compliance by simply passing the cursor over the desired icon.  This can be very useful in such cases 
where the user has selected a FDOT Menu Help icon which opens the information in the browser. To 
dismiss the browser the user must simply place a data point or reset within the MicroStation design file. 
To bring back the browser the user would simply pass the cursor over the blue icon and the browser will 
be reopened at the previously selected site or help file location. 
 

                                                                                     
 

 
 

 
 
 
 
  
 
 
 

Access RW Hot List

Access Browser 

Check Design file 

Run QuikChek

Run PlotScale 
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9.2.4 R/W Attachments 
 
The R/W Attachments selection provides options for attaching the Right of Way Mapping cell libraries for 
English (row.cel) projects, determining the “Currently Attached Cell Library” which displays results in the 
MicroStation message window, “Attach Other Cell Libraries” which displays the MicroStation Cell Utility 
dialog. 
 

 
 

9.2.5 R/W Map Sheets 
Note: A Help button is located to the left of the category name containing help information on that menu 
selection.  

 
 
 
 
 
This option places various R/W Map sheet cells of the user’s choice in the active design file. The 
user simply selects the type of sheet cell, and places it in the file. When the R/W Tabulation Sheets 
(Geopak Tables) is selected, the tabulation sheet will be placed in the design file at the scale of 
1”=20’. This accommodates the use of Geopak Table Tutorial text placement. When selected, the 
Launch Geopak Tables provides a short cut to launch the Geopak Table Tutorial dialog.  
 
  

Help Button 
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• RW Tab Sheet (Axiom)  
  

 Selecting R/W Tabulation Sheet (AS = 1:1) places 
a R/W Tabulation sheet into the current design file 
at a 1:1 scale. The user should have previously 
created a RWTAB__.DGN standard design file for 
tabulation data. 
 
Selecting Edit Excel Sheet (RWTABULATION) will 
create an Excel spreadsheet entitled 
“rwtabulation01.xls” into the user’s current dgn 
directory. 
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Warning:  Do not adjust column widths on spreadsheet or data will not be placed correctly on 
tabulation sheet. 

 
This spreadsheet is specifically designed to work with Axiom’s “Microsoft Office Importer for V8”. 
Consultants can contact Axiom, Inc to purchase the program. 
 
The Office Importer requires the use of an “ini” file for specific settings. For R/W this file is called office.ini 
and is located in the C:\fdot2008\resources\data directory. The user should check that this file is 
attached by first opening the Office Importer dialog as shown: 

 
 
 
Once selected, the Office Importer dialog box should appear and the user 
should select the Settings button as shown: 
 
 
 

 
The Settings dialog should display the required file attached. If the 
required office.ini is not attached then the correct file can be accessed 
by selecting: 
 
 
 
Warning: Do not make any adjustments to the current settings in 
the office.ini file or the program will not work correctly. 
 
The Excel spreadsheet can be edited for additional data by placing the required information in 
each column and saving the file. Once data has been saved, the rows that are to be added to 
the tabulation sheet can be highlighted by standard window operations and then selection 
Edit>Copy. Excel will display a highlighted border around the selected data.  To place this 
data onto the tabulation sheet select the Paste button. 
 



FDOT CADD Production Criteria Handbook  Effective: January 27, 2009            
Office: Engineering/CADD Systems                                                        FDOT2008 XM MR1 Update 
 

 
Right of Way Mapping – CADD Production Criteria Handbook 9-28 

After the Office Importer Paste button has been selected the data will be attached to the dgn cursor with 
a border displayed surrounding the copied information. 
 

 
 
 
 
 
 
 
 
 
 
 
 

 
The data can be placed on any line within the tabulation sheet by placing a tentative button at the upper 
left corner of the desired line and then accepted by a data point. 
 
Changes to the existing data can be accomplished by selecting the Manage button.  
  
The "Manage" tool on the main dialog box allows you to update linked information manually, edit the 
source document or change the status of the links. 
After the Manage button has been selected the user will be prompted: 
 
Manage Import Link > Identify element 
 
Click any portion of the part of the linked data that you want to update, and the "Manage Import Link" 
dialog box will appear. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Update button must be selected for data to be changed. Office Importer will also update linked data 
that has been changed in the current spreadsheet each time the linked design file is opened. For 
additional information refer to the Office Importer Help selection. 
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• Create Cover Sheet > With Map(DGN) 

 
 

This option automates the creation of the various right of way map cover sheets for “Control Survey”, 
“Right of Way Map”, and “Maintenance Map”.  
 

 
 
 

o Key Map Type - gives you a choice of three different R/W Cover Map Sheet Types for 
Right of Way Mapping: 

 
 
 
 
 
 
 

Selection Cover Sheet  

Control Survey Control Survey Cover Sheet  

R/W Map Right of Way Map Cover Sheet 

Maintenance Maintenance Map Cover Sheet  
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o DGN FILE Name - The name of the design file that the Cover Sheet is drawn in.  The 
Cover Sheet will be placed at the center of the Design Plane. The DGN file will have the 
proper naming convention (rwcovr01.dgn). Unlike 'Create File' this option will not 
increment the file name (rwcovr01..02..03). The New button when selected displays the 
file location dialog for selecting a new/different design file name or location.  

 
o Co. Map Name - The name of the County Map that the clip area will be taken from.  The 

Map can be local on the workstation or remote via a NFS mount on the Server. The 
Browse button when selected displays the file location dialog for selecting a new/different 
county map design file name or location.  

 
o Clip Area Size X: and Clip Area Size Y - This value is used to adjust the size of the clip 

area (within limits).  The default size of the clip area for the metric version is 0.085 meters 
on each side (@ 1:1 scale).  The values can be adjusted up and down, within limits, 
independently in the X and Y. The Slider Bar below each one will adjust the values or 
they can be keyed-in.  

 
o Lower Left X: Y: and the Upper Right X: Y:  - This entry defines the clipping 

coordinates. The coordinates are generally for information only, since the coordinates are 
normally set with the Define Clip Area Button. But if the user knows the clipping 
coordinates, they can be manually typed into these fields. 
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o Define Clip Area - This button will retrieve the county map design file that is to be 
clipped.  A rectangle that represents the clipping area will be attached to the cursor.  The 
rectangle defines the area that will be clipped out and moved to the Cover Sheet. The 
placement of the rectangle can be manipulated by MicroStation commands to position 
the project location map as desired.  Select the area to clip with a data point.  The lower 
left and upper right coordinates will be displayed in the coordinate fields of the dialog box 
(Lower Left X: Y:, Upper Right X: Y:). 
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o Clip Key Map - This button will attach the County Map File as a reference file and clip 

the area designated as the project location map into the Output Design File. The Clipped 
Area will be scaled accordingly English or Metric Units.  During processing, if the Cells 
needed to create the cover sheet cannot be located (no library or wrong library attached), 
then the application will pop up a message informing the user of this problem and prompt 
the user to select OK to attach the correct Cell Library or CANCEL to Stop Processing.  If 
OK is selected, the Cell Library Open dialog box will appear. If the MX_LIBDIR variable is 
set to the correct location (Metric or English), then the user will be presented with a list of 
cell libraries to attach.  If it is not set, then the user must navigate to the correct location 
of the cell library.  When the drawing is complete, the application will do a FIT command 
and SAVE DESIGN. 

 
9.2.6 Line Style Tools 
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• Modify Custom Line Styles 
 

 
 

o Shift Custom Line Style - Dynamically shifts the custom line style pattern when the line 
style is selected by a data point and the cursor is then moved parallel to the line. When 
the line style is shifted to the desired position/appearance another data point will accept 
the change. 

 
o Scale Custom Line Style - Dynamically scales the custom line style pattern when the 

line style is selected by a data point and the cursor is then moved parallel to the line. 
When the line style is scaled to the desired amount another data point will accept the 
change. 

 
 

o Scale All Custom Line Styles - When selected the dialog shown below should appear. 
Select the desired custom line style scale and then click on the Scale Lines button ALL 
custom line styles in the current design file will be scaled. 

 

 
 

o   
o Set Custom Line Style Scale - The custom line styles scale can be changed for other plot 

scales by selecting Set Custom Line Style Scale option shown above. This will open the 
R/W Custom Line Style Scale dialog box. (shown below) The user may then select from 
the Scale 1” = pull down list for standard mapping scales or select from the pull down 
Keyin Scale = and type in the desired scale in the text window. Opening the MicroStation 
Line Styles dialog box from the main menu, and toggling on Show Details can check this. 
This dialog must be reopened each time the scale is changed from the FDOT Menu if the 
user desires to check the current scale factor, as the dialog is not dynamic. (See the 
MicroStation Help files for instructions on Line Styles). 
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• Leader Lines, Tie Lines and Station/Offset Lines  
 

 
 
 
These three categories, which can be found and set through the MicroStation V8 Level Manager, contain 
the same list of items for setting the symbologies of each line type listed in the Line Style Tools menu. 
The symbologies for Leader Lines and Tie Lines have required symbology standards. Station-Offset 
Lines will be placed on the corresponding Text ByLevel. A diagram of each category and their typical use 
is shown below: 
 
                            LLeeaaddeerr  LLiinnee                 SSttaattiioonn//OOffffsseett  TTiiee  LLiinnee 
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9.2.7 Text Tools 
 
The Text Tools menu selection provides the user with various tools for placing, editing and modifying text 
for annotating Right of Way Mapping design files.  
 

 
 
 

• Set Text Size  
Sets the standard default text size for the selected design file scale. For example, if the user selects 
“1 Inch = 100 Feet” the default standard text size will be set to TH = 10’, TW = 10’. The user should 
not attempt to use one text size for all text placed in the design file. 
 
 

 
 
 
As stated, Readability of text data should be considered as priority, however no text should be smaller 
than 3.2’ on a 1” = 40’ scale (0.08” actual plotted size). 
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9.2.8 Cells  
 
This option lists the R/W Mapping 
CADD Standard cells for 
placement into design files. Active 
scale can be set by selecting Set 
Cell Scale. All other MicroStation 
settings should be considered prior 
to cell placement. The user should 
assure that the required cell library 
has been attached for the 
appropriate workspace.  
 
 
 
 
 
 
 
 
 
 
 
 
 

• North Arrow 
 
 

 
 
 
 
 
 
 

o North Arrow - This command automates the process of placing a north arrow. The 
English cell library row.cel must be attached to the current design file. The program will 
prompt the user if it cannot find the required cell library. 
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• Place Spring Line 

 

 
 

o R/W Mapping Spring Line - This command 
automates the process of placing a spring line for 
lines that are partially deleted in order to fit 
mapping area limits. The English cell library 
row.cel must be attached to the current design 
file. The program will prompt the user if it cannot 
find the required cell library. 

 
o Match Line Symbology - R/W Mapping 

standards require that spring lines be placed using the same line symbology for the line 
type being used. The button will prompt the user to select the associated line and will set 
the required symbology in MicroStation. 

 
Scale 1” = Sets the required scale for R/W Mapping standards for 
placement of the spring line.  
 
Keyin = setting can also be selected from the pull down list and a non-
standard scale keyed into the text window. 
 
After selecting the OK button the program will prompt for a Tentative Data 
Point on the line and at the point to place the spring line. The program will 
prompt the user to accept or reject the point. If a second data point is given 
the spring line will be placed at the proper angle and location as shown 
below. 

 
 ........................................................................................................................................................................   
 
 

• Place Bar Scale  
This command opens the R/W Mapping English Bar Scale 
dialog which displays the list of available standard Bar Scales 
for various mapping scales. Once the desired Bar Scale is 
selected and the Place button is pressed the bar scale cell will 
be attached to the cursor for placement.  
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• Monuments 
Provides access to all monument cells created 
in the English libraries. Monument  cells that are 
described as Solid are area filled and require 
the MicroStation Settings > View Attributes 
“Fill” selection be turned on for proper display. 

 
 
 
 
 

• Curve Data 
Contains all cells used for creating full curve data 
layout or segment curve data. Baseline Curve Data, 
Segment Curve C.B. (C.B. = Chord Bearing),  
Segment Curve C.D. &C.B. (C.D. &C.B. = Chord 
Distance and Chord Bearing) and Segment Curve 
T.B. (T.B. = Tangent Bearing) are the basic curve 
data information required for R/W Mapping.  Each of 
these cells is used in association with the Geopak 
Table-Tutorial program including the Curve Data Box, 
Baseline Curve Data Box and Coordinate Data Box. 
 

o Launch Geopak Curve Calc - It’s the Geopak curve data application that provides quick 
curve data calculations for reviewing curve data information. The program requires at 
least two curve elements for computing the curve data as provided in the two pull down 
selection lists. The program will also maintain each Computed solution (Solution#1, 
Solution#2 …) until the Clear button is selected. This curve data is for informational 
review only and cannot be placed into the design file. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  



FDOT CADD Production Criteria Handbook  Effective: January 27, 2009            
Office: Engineering/CADD Systems                                                        FDOT2008 XM MR1 Update 
 

 
Right of Way Mapping – CADD Production Criteria Handbook 9-39 

9.2.9 Arrows 
 
The Arrows menu selection provides several delimiter types and terminators for use in the R/W Mapping 
procedures. Most of the delimiters are built using custom line styles and many contain filled areas and 
therefore the Fill Attribute setting should be turned on as previously mentioned. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

• Place Delineators 
 

 
 
 
R/W Mapping Delineators – This command automates the process of placing delineator arrows for 
bearing and distance or other delineated line segmented data. After selecting the program you will need 
to select the text element using the Element Selection tool that the delineators are to be placed on then 
press the Select Text to Match button, choose the scale that you would like the delineators place at from 
the pull down and then press the Set Plot Scale button. Then choose the line that the delineators need to 
be placed on and the program will find the beginning and ending points of the line segment, and then 
choose how you want the delineator placed. Delineators will then be placed at the beginning and end 
point of the line segment. 
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o Select Text to Match – R/W Mapping 

standards require that delineator arrows be 
placed using the associated text symbology for 
the line type being used.  

 
Use the element selection tool 

to select the associated text then press the 
Select Text to Match button and the required 
symbology will be set in Text Level Selected 
box. 

 
 
 
 
 
 

o Select Your Plot Scale – Sets the required scale for R/W Mapping standards for 
placement of the delineator arrows. Multiple scales are place in the pull down. 

 

 
 

o Leader Above Line – This option will place delineators with an arc and terminator arrow 
as shown below depending on the direction the line was original drawn in. 

 

 
 

o Leader Below Line – This option will place delineators with an arc and terminator arrow 
as shown below depending on the direction the line was original drawn in. 

 

 
 

o Arrows In-Line – This option places delineator arrows at the end of the line segment as 
shown below. 
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• Begin/End Baseline Flag Right/Left 
 
This selection provides access to custom line styles used in delineating Begin/End of projects, R/W 
acquisitions and similar graphic elements. 
 

 
 
 
 
When placing these custom line styles the MicroStation “Place 
SmartLine” command should be used with the “Join Elements” turned 
ON as shown below. This setting will eliminate additional arrow 
delineators if multiple line segments are placed.  
 
 
 

 
               Join Element Off                      Join Element On 
 
 
 

9.2.10 Certification Notes 
 

 
 
 
The Certification Notes menu item provides the user with a list of all the standard certification notes 
used in various R/W maps. The first selection Text Import Settings will set the standard text 
requirements for TX= (text size), LS= (line spacing) and LL = (line length) for the given scale. After 
selecting New Certification Notes the user is presented with the R/W Mapping Certification Notes 
dialog shown below.  This dialog contains the list of certification notes by which the user may scroll up or 
down, select the desired note and then select the OK button. The selected certification note, such as 
Control Survey Certification, shown as selected in the dialog below will then open a MicroStation Basic 
macro dialog box containing areas for information input that are required for the selected certification 
note. 
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Once all required information has been input into the corresponding dialog for the certification note 
the user then selects OK. The program will search the certification notes directory for the required 
note and copy the note to the users working directory. An Alert dialog will display the directory path 
in which the note has been copied and prompt the user to continue or exit by selecting No. 
 
 
Note: Each certification note is created with a unique name and should not be changed by the user. 
 

 
 
 
If the user selects Yes, the note will then be overwritten and all information previously supplied 
by the user will be placed into the required locations within the note. The note will then be 
placed into a text editor dialog as shown below for any additional editing.   
 



FDOT CADD Production Criteria Handbook  Effective: January 27, 2009            
Office: Engineering/CADD Systems                                                        FDOT2008 XM MR1 Update 
 

 
Right of Way Mapping – CADD Production Criteria Handbook 9-43 

 
 
 
If additional changes to the note are made the user should save these changes by selecting Save>File. 
Selecting Tools>Import Text from the editor dialog and then place the certification note into the design 
file.  The certification note will be attached to the MicroStation cursor for placement by a data point into 
the design file.   
 
 
There are two methods for editing an existing certification note. In the first method the user should be 
located in the required working directory for the program to find the existing note.  By selecting 
Certification Notes > New Certification Notes, which will again display the R/W Mapping Certification 
Notes dialog, the user can then select the name of an existing note previously created in that directory. 
The dialog shown below will prompt the user to edit the existing note by selecting Edit and the note will 
then be placed into a text editor, or create a new note by selecting New in which the corresponding input 
dialog for that note will be displayed. 
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The second method is to select Certification Notes >Edit Certification Note, which will open the text 
editor and Open Source File dialog allowing the user to navigate to the desired certification note for 
editing.  
 

 
 
 

9.2.11 Legal Descriptions 
 

 
 

The Legal Descriptions menu selection provides the user with the ability to create two standard parcel 
legal description types commonly used by FDOT R/W Mapping offices. This program works in 
combination with Geopak’s Legal Description Editor and therefore derives coordinate data, curve data 
and distance and bearing input directly from Geopak’s Coordinate Geometry program.  
 
Because of the many diverse ways to compose legal descriptions it is not possible to cover all types of 
legal description styles within this program. But with these basic templates and the Legal Description 
Editor the user can compose the desired description without the possibility of transposition errors. Once 
the description is complete the file can be saved from the editor to an ASCII (.txt) text file and then 
imported to a word processor, such as Microsoft Word for any additional editing. 
 
To begin the composition the user should first select from the FDOT Menu Legal Description > Geopak 
Legal Description Editor. Geopak will prompt for a coordinate geometry database Job number. If the 
Job number is not known the Select button can be used to select from a list of Job numbers in the current 
project directory (defined in Geopak Preferences). Once the Job number is selected the OK button will 
open the Legal Description Editor as shown below. 
 
The instructions for using Geopak’s Legal Description Editor are too extensive to describe within this 
document. The user should consult Geopak’s manuals or Geopak’s’ Help files for complete instructions. 
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Select from the FDOT Menu Legal Descriptions > RW Mapping Legal Descriptions, this will open the 
program dialog shown below GEOPAK Legal Description Editor must be running for this application to 
work. 

 
 
There are two description options to select from:  
 

o Metes and Bounds/Section–Twp&Rge – This selection will create a standard metes 
and bounds legal description contained within a defined section, township and range.  
The program will prompt the user for all required information to complete the legal 
description. 
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Include Point of Commencement Chain – If this option is selected the program will prompt the user 
for a previously stored geometry chain name to describe the traverse from the point of 
commencement to the point of beginning.  It is suggested the commencement chain name be 
described to associate the chain with the corresponding parcel, such as “100C”. The resulting 
description will be similar to the one shown below. 

 

o Metes and Bounds/Lot(s) and Block(s) – This selection will create a standard metes 
and bounds legal description for Lot(s) and Block(s) or for inserting a parent tract 
description.  

 

Include Point of Commencement Chain – If this option is selected the program will prompt the user 
for a previously stored geometry chain name to describe the traverse from the point of 
commencement to the point of beginning.  It is suggested the commencement chain name be 
described to associate the chain with the corresponding parcel, such as “100C”.  

 

Insert Parent Tract Description – If this option is used, the program will create at the proper location 
a line stating “[Insert Parent Tract Description Here]”. The user then has the option to manually type 
the tract description or cut and paste the description into the editor at the required location.  The 
resulting description will be similar to the one shown below. 
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Insert Parent Tract Description – If this option is not used, the program will prompt the user to input 
the Lot number(s) in place of the parent tract description. The resulting description will be similar to 
the one shown here. 

 
 

 
 

9.2.12 Tool Boxes 
The Tool Boxes provides a variety of tools for drafting purposes. Brief descriptions of some of these tools 
are described below. The user should practice use of these various tools to determine which tools best fit 
their needs during mapping production. 
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• AA-AS 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 

• Lines2 
 

 
 

The Lines2 dialog combines most MicroStation 4.0 and 5.0 line construction tools no longer located on 
later versions into a single dialog box for easy access by the user. This dialog box is dockable on any 
border of the working area. 

 
• Views2 

 
The Views2 dialog combines some of the 
original view manipulation tools (the first six 
selections) with additional windowing tools. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Sets the active angle by two data points.

Sets the active angle by three data points.

Set active scale by three data points.

Sets the active angle by data point on the element. 

Sets the active angle back to “0”.

Brings up the active angle dialog box. 

Changes an element’s direction or start point. Used 
for reversing the direction of custom line styles. 

Fit reference file to view. 

Fit design and reference files to view. 

Changes view to Previous view manipulations 
by each data point in selected view. 

Changes view to Next view manipulations by 
each data point in selected view.
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• Arcs2 
 
The Arcs2 dialog contains tools for the creating of curves and ellipses by various methods and tools for 
modifying these elements. Some of these tools will display additional dialogs for precise user input. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

Place half ellipse by three points. 

Place quarter ellipses with begin point, radius point and end point. 

Modify arc radius with data point on arc element. 

Modify arc angle with data point on arc element. 

Modify arc axis with data point on arc element. 

Construct circle tangent to elements. 

Construct circle tangent to three elements. 

Construct tangent arc by radius. 

Construct arc tangent to elements. 
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• CivTools (Civil/Site Tools) 
 
The CivTools (Civil/Site Tools) dialog contains several tools for placement of civil and site type 
elements into a design file. Each of these tools also contains additional dialogs for precise input by the 
users. The Parameters for Civil Tools dialog contains settings for element attributes including text size 
and element symbologies for each of the tools on this dialog. 
 

       
 
 
 
  

Place Contour 

Label Contour, must be 3D 

Place N-E Coordinates 

Modify Contour 

Set Element Elevation

Place Spot Elevation 

Place Composite Curve

Place  Breakline 
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9.2.13 QC-Std  
 

 
 

 
Note: The following topics contain a brief description on using the QC tools, for in-depth instructions use 
the online help documentation that can be accessed from the FDOT Menu at QC Help or from the QC 
Tool Box icon: 
 
 
This option provides the user with the ability to complete a "Quality Control" review of all mapping project 
types produced by Right of Way Mapping. This is accomplished through the use of four “QC” tools and 
their related “Rule” files. These rule files have the extension of .rul and contain the standard symbology 
requirements for elements placed in a right of way design file project.  For right of way mapping the rule 
file name for 2008 English is rweng08.rul. The directory location for this file is 
fdot2008\QC_Rules\std_2008. These are binary files and cannot be changed or modified by the user. 
 
These QC tools will process each element in a file sequentially comparing each element found against 
the selected rule file. As each element is processed, all rules are evaluated to see which one most closely 
matches the element. Only one rule is used to process an element. An element will not be processed by 
any rule unless the element meets all the selection criteria in that rule. 
 
For an example consider three rules with these selection criteria: 
 
a) Level  
b) Level, color  
c) Level, color, weight  
 
Rule (c) is most specific, and will be applied to all elements that match on all three criteria: level, 
color, and weight.  All elements matching (c) also match (a) and (b) but (c) will score the higher 
value and will therefore be used. Similarly, rule (b) will be used for all elements that have level 3 and 
color 2 (and not weight 4). Any elements that are level 3 (and not color 2) will be processed by rule 
(a). 
 
The user may select each QC tool from the pull down menu on the FDOT Menu or by selecting Load QC 
Tool Box. The user can then access each QC tool via the dialog box shown below:  

    
 
 
 
 
Note: The QC Tools dialog box is a dock able menu.  
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9.3 Geopak’s Plan View Labeler 
 
The Plan View Labeler tool provides the user with numerous methods to create annotation for 
design file project data. This annotation can include user type data supplied by the user or computed 
data created from Geopak and MicroStation elements. The labeling tool can be accessed by 
selecting Application>Geopak Roads or Geopak Survey>Plans Preparations>Plan View 
Labeling. The labeling tool can also be accessed from the Geopak Survey Tools menu or Geopak 
Road Tools menu as shown below: 
 

 

 
 
 
 
 
When selected the Plan View Labeler dialog will be displayed as shown below: 
 
Note: The use of this dialog is to extensive to allow for detailed instructions within this 
document. The user should refer to the Geopak Help for complete detailed instructions. 
 
 

 
 
 
One of the main uses for this labeling tool is the creation of labeling styles that can be saved for 
future use. A Right of Way Mapping style file has been created called RW.LSF, which contains 
useful annotation styles for placement of required mapping data.  These styles are listed under the 
category RW-Labels. The user may add additional styles to this category for specific labeling used 
at their site. It is, however, recommended that the file be saved as a different name than the original 
in order to prevent the edited version from being written over during future updates of the CADD 
software. The currently attached style file can be determined by viewing the information banner at 
the top of the dialog.  
 

Plan View Labeler 
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• Text  
 
This tab contains specific items that will need to be set and selection inputs in order for the labeler to 
work with the current design file and Geopak geometry data. 
 

o Job No. – The Geopak job number for the current design file must be input. The Select 
button can be used and Geopak will display a dialog listing the .gpk geometry database 
files in the current Geopak project. 

 
o Chain – Select the geometry chain name that will be used to compute data such as 

station and offsets. 
 

o Computed Inserts – When selected the Computed Text insert list is made available for 
use as shown above. The element type selected in the design file determines the type of 
computed text inserts displayed linear or curved.  

 
o User Inserts – When selected the item selection window changes to the User Text and 

displays text provided from the rwlabels.ins file located in the FDOT2008\Geopak\-\bin 
directory. Text items can be added to this file by inserting each text item on a single line. 

 

 
o Label Feature – There are two selections that the user should select here for most all of 

the R/W Mapping labels. Press the Geopak/MicroStation Element button, and then select 
a GEOPAK or MicroStation element to utilize within computed text inserts. Press the 
Data Point button, then issue a data point on the screen. Functions include locating the 
text placement point, identifying a point for calculation of the computer text inserts, ect. 

 
 
 
 Geopak/MicroStation Data Point 
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• Styles 
This tab provides access to label styles previously created or for creating additional labels. The label 
style can be selected by double clicking the style name in the Item Selector window. The following is 
a brief description of the labels currently available in the rw.lsf file: 
 

 
 

o BaseLineCurve - Places the standard R/W Mapping baseline 
curve data format. The user should select the 
Geopak/MicroStation button located on the Text tab and then 
select by data point the desired baseline curve element previously 
plotted into the design file. The curve element will be highlighted 
and then accepted with the second data point. The curve data will 
then be attached to the cursor for location placement by data 
point. 

 
 

o SegCur/CB – Places the standard R/W Mapping segmented curve data with Chord 
Bearing. The user should select the Geopak/MicroStation button located on the Text tab 
and then select by data point the desired baseline curve element previously plotted into 
the design file. The curve element will be highlighted and then accepted with the second 
data point. The curve data will then be attached to the cursor for location placement by 
data point. 

 
 
 

o SegCur/CB&CD - Places the standard R/W Mapping 
segmented curve data with Chord Bearing and Chord Distance. The user should select 
the Geopak/MicroStation button located on the Text tab and then select by data point the 
desired baseline curve element previously plotted into the design file. The curve element 
will be highlighted and then accepted with the second data point. The curve data will then 
be attached to the cursor for location placement by data point. 
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o Bear/Dist. and Bear.00/Dist. – Places the standard R/W Mapping bearing and distance 
format for linear elements stored in the design file. The Bear.00/Dist format places a 
bearing with seconds to two decimal places. The user should select the 
Geopak/MicroStation button located on the Text tab and then select by data point the 
linear element to be labeled. The linear element will be highlighted and then accepted by 
a second data point. The distance and bearing will then be attached to the cursor for 
location and placement. The text justification for the label is set to center/center; this 
allows the label to be placed with the desired spacing by a tentative point on the linear 
element. 

 
 
 
 
 
 

o Dist-Bear and Dist-Bear.00  - These styles are basically the same as the previous styles 
except the label places the distance and bearing of the linear element on a single text line 
as shown below: 
 

 
 
 
 
 
 
 
 

o NECoords. and XYCoords. – These two styles place coordinate data information (four 
decimal places) associated with a stored Geopak point or any data point location in the 
design file. The user should select the Data Point button located on the Text tab. 
Associated with these label styles is a leader line as shown on the Leader tab below. The 
leader line settings are automatically set as part of the saved label style. These defined 
settings for the leader line are, under Leader Type as a One Point Leader and under 
Terminator as an AT or current Active Terminator.  

 
Other AT terminators can be selected by using the MicroStation key-in “AT =” or can be 
selected from the R/W Mapping FDOT Menu under the ARROWS menu item. The AT 
terminator scale can also be set at ARROWS>Set Terminator Scale> on the FDOT Menu. 
 
Note: It is suggested that the user select the graphic type terminator cells provided on the 
Right of Way FDOT Menu. Geopak will place these as special Geopak cells in the associated 
symbology. This will eliminate the problem of non-rotating point cells if the design file is 
rotated. 

  

Tentative 

Tentative Point 
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Once a data point in the design file has been selected the associated coordinate values 
for that point will be displayed in the Labeler dialog. Select the Place Label button to 
attach the coordinate labels to the cursor for placement. The next data point defines the 
location of the label from the selected point. The user is then given the option to place 
the leader line to the right or left side of the label by moving the cursor right or left of the 
label. Once this has been determined a data point will place the terminator line with the 
terminator at the location of the selected point. 

 
 
 
 
 
 
 

o Full Station/Offset and Part. Station/Offset - These two label styles allow the user to 
place station and offset data associated with a Geopak point or any data point location in 
the design file.  The Full Station/Offset label places the whole station value while the Part. 
Station/Offset label places only the plus station value. The desired stationed Geopak 
chain that will be used to compute the station and offset values should be selected in the 
Text tab Chain window. The Data Point button should also 
be selected in the Text tab dialog. The leader line 
associated with this label style and procedures for placing 
these labels are the same as described in the previous 
label style.  

 
 

 
o Parcel Bubble – This label style was created to assist the user in quickly placing 

standard parcel bubbles with the required parcel number and leader line. The Parcel 
Bubble is created with a circle shape selected on the Shape tab dialog. Also a leader line 
has been associated as previously described but with the Terminator selection being No 
Terminator. The required R/W symbologies have been set for this label style as there is 
only one symbology standard used with parcel bubbles. The user should use the Data 
Point Location button located on the Text tab dialog for placement of the parcel bubble.  
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Editing the number displayed in the Labeler text window will change the 
parcel number. For best results, once the Parcel Bubble style has been 
selected the user should open the Text tab dialog and select the Data Point 
button for placement of each parcel bubble. The next step is to select the 
Place Label button and the parcel bubble will then be attached to the cursor 
for placement. The second data point will place the parcel bubble at the 
desired location and a graduated circle will be displayed to assist in placing 
the leader line as shown. The next data point will define the location of the 
beginning of the leader line from the parcel bubble with the leader line 
attached to the cursor.  
 
The last data point will determine the direction and terminus point of the leader 
line as shown below.  To continue placing parcel bubbles do not reset, but 
simply change the parcel number in the text label window and the parcel 
number will be updated automatically. 

 
• Params 

When using the Plan View Labeler it is important to set the required R/W Mapping CADD 
symbologies for that label. The quickest way to set these required symbologies is to use the R/W 
Mapping FDOT Menu in combination with the labeler.  This can be accomplished, for example, by 
using the Right of Way FDOT Menu to set symbologies for text at the Text Symb>RW Text 
Symbologies menu item and then selecting the desired text element.  This will set symbologies for 
level, color and weight. From the same menu location the text size can be set at Text Symb>Set 
Text Size. Once all required symbologies are set in MicroStation these settings can be transferred to 
the Labeler using the following methods located on the Params. tab dialog shown below: 
 

        
 
 
 
 
 
 
 
  

Set By Current – Selecting this button will set the Labeler text to the current 
MicroStation text symbology. Symbologies for Shape and Leader are not set 
and must be set separately.  

D&C Symbology – Selecting this button will open the Geopak Design 
and Computation Manager in which the user can select an element and 
that element’s symbology will be used. 

Set All Parameters – When this button is selected the symbologies 
set in the current tab dialog are used to set the symbologies for all 
tabs containing symbology settings. 
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9.4 Plan Sheet Layout 
 

  
 

The FDOT CADD Software also provides a standard Sheet Library file for R/W Mapping called 
RWMAPS.PSL to be used with the Plan Sheet Layout program.   
 
This version of Geopak’s Plan/Profile sheet clipping program contains, in most part, the same procedures 
as the Classic version previously described, with some additional enhancements. 
 
In the Plan Sheet Layout program all sheet layouts for R/W are contained in this single library file 
rwmaps.psl. 
 
The following table lists the available R/W Sheet Layouts: 
 

Sheet Name Description Scale Sheet Type 

CSDETL Control Survey Detail Any 
Scale 

Plan (Port1) 

CSKEYM Control Survey Keymap Any Scale Plan (Port1) 
MMDETL Maintenance Detail Sheet Any Scale Plan (Port1) 
MMKEYM Maintenance Keymap Any Scale Plan (Port1)

RWDETL Right of Way Detail Any Scale Plan (Port1) 

RWKEYM Right of Way Keymap Any Scale Plan (Port1) 
RWPSL Right of Way Parcel Sketch (Landscape) Any Scale Plan (8.5” x 14”) (Port1)

RWPSP Right of Way Parcel Sketch (Portrait) Any Scale Plan (8.5” x 14”) (Port1)

RWMAPS Used for ALL R/W Sheet Types w/ Auto - 
Title Block Annotation Any Scale Plan (Port1) 

 
 

9.4.1 Creating R/W Plan Sheets 
 

From the MicroStation Civil Extension select the Plan/Profile icon.  
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Before beginning the clipping process make sure the correct sheet layout library is attached. The 
currently attached library name is displayed at the top of the Sheet Layout dialog as shown: 

 
 

 

 
 

 
Select the R/W sheet name from the pull down list and input the desired plot scale in the text window 
to be used during the clipping process. 

 
For complete detailed instructions see Geopak documentation. 
 

9.5 Design and Computation Manager 
 

9.5.1 Selection of R/W Database (English) 
 
The Right of Way Mapping database file is entitled RW_2008ENG.DDB. 
The file can be accessed through the MicroStation main menu by selecting: 
Applications>MicroStation Civil Extensions> Design & Computation Manager 
Or through the Geopak main menu by selecting:  
Applications>Geopak Road> Design & Computation Manager  
or by selecting the icon located on the Geopak Road Tools dialog shown. 
 
  
 
 
 
This database contains one main category, for plotting elements in English units. When the D&C 
Manager is accessed for the first time after installing the FDOT2008 CADD software the user may need 
to select from the Design and Computation Manager File > Open. Then from the file listing select 
rw_2008eng.ddb as shown:  
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9.6 Geopak Feature Preferences 
 
Geopak COGO has the ability to plot design file elements which contain drawing parameters including 
element symbology, attribute drawing options and DTM controls. These Feature attributes are defined in 
a Survey Database with a file extension of .SMD. The FDOT2008 software contains the database 
fdot2008.smd with the following categories: 
 

Default Feature 
Location Survey 
Right of Way 
Roadway 

 
This database should be automatically attached as the default when using the FDOT2008 software which 
is defined by the Geopak configuration variable GPK_SURVMNGR_SMDFILE.   
 
The user can verify which database is being used or change to another database from the Geopak User 
Preferences dialog. This dialog can be accessed by selecting form the Applications menu 
Geopak>Road/Site/Survey>Preferences.  Select the Feature Preference… button to display the 
Feature Preference dialog shown below. 

               
 

                         
 
The Feature Preference dialog contains the following items: 
 

o SMD File: Displays the current working database. A different working database can be 
located and attached by the Select… button. 

 
o Edit SMD… This button will bring up the Survey Preference dialog for editing the 

database much in the same method as the Design and Computation Manager.  
 

o Apply Best Match Feature - When this toggle is active, the best match feature from the 
feature survey preference database is utilized. In the fdot2008.smd database the Default 
Feature category will be used if the active feature does not match a feature item in the 
current database category. 

 



FDOT CADD Production Criteria Handbook  Effective: January 27, 2009            
Office: Engineering/CADD Systems                                                        FDOT2008 XM MR1 Update 
 

 
Right of Way Mapping – CADD Production Criteria Handbook 9-61 

o Plot Scale: Defines the scale at which linear elements such as custom line styles and 
cells will be plotted.  It is important that the user set this prior to plotting elements into the 
design file project from the Coordinate Geometry dialog. 

 
There are three Visualization settings on the Coordinate Geometry dialog used to control plotting of 
feature elements into the design file: 
 

o Disable Visualization - When active no elements are visualized during the COGO 
session. 

 
o Temporary Visualization - When active elements utilizing the feature symbology (or 

default symbology if no feature is present) are displayed during the COGO session. 
 

o Permanent Visualization - When active elements utilizing the feature symbology (or 
default symbology if no feature is present) are displayed during the COGO session. Upon 
exiting the COGO session the elements remain in the design file. 

 
There are two Feature settings on the Coordinate Geometry dialog used to control plotting of feature 
elements into the design file: 

 

 
 

o OFF (Feature) - When the Off option is set, any element subsequently stored does not 
have a Feature attached. 

 
o Delete (Feature) - The Delete Feature deletes any feature on subsequent commands, or 

does not attach features to newly stored elements. 
 

9.7 Working With R/W Metric Design Files & MicroStation V8 
 
The Engineering CADD Systems Office (ECSO) provides limited support for metric unit CADD design 
files. This support consists mainly of bringing forward previous versions of metric support files such as the 
English and Metric files provided within the FDOT2002 CADD software.  
   
Right of Way Mapping CADD users working on revisions to metric design files in MicroStation 
V8/FDOT2008 CADD software will need to be aware of some specific procedures when working in Metric: 
 
In previous versions of FDOT CADD software such as the FDOT2002 version ECSO provided 
MicroStation “Workspaces” that allowed the user to easily work in English or Metric environments.  These 
two workspaces were entitled “sitefdoteng” and “sitefdotmet” respectively.  These workspaces 
automatically provided settings needed to work within the required units. The FDOT2008 workspace is 
based on support for English units as this is the required unit for all future design projects with FDOT.  
The workspaces provided are as follows: 
 

o FDOT2008 – uses the V8 file format and FDOT2008 CADD standards. This option 
requires existing files to be converted for both file format and CADD Standards. All new 
supporting files and programs are accessible. 

o FDOT2002_V8 – uses the V8 file format with FDOT2002 CADD Standards. This option 
only requires existing files to be converted to the new file format. Requires the use of old 
support files (i.e. criteria files, Geopak support databases, etc.) 

o FDOT2002_V7 – maintains the V7 files format, by forcing MicroStation to operate in V7 
Work mode, and uses the FDOT2002 CADD standards. Requires no conversion, but 
significantly reduces the capabilities of Geopak. 
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o For the purpose of working on revisions to RW Metric design files, it is recommended that 
the user select the FDOT2002_V8 workspace provided and the FDOT2002 interface 
setting.  The MicroStation Manager dialog workspace “User” and “Interface” settings 
should appear as shown: 

 

 
 
 
After selecting the desired design file MicroStation will prompt the user with the following dialog for design 
files that are not in V8 format. Since this file is being edited for revision purposes only and is to maintain 
original V7 level settings there should be no need to convert these to new V8 level names.  The user 
should select “Upgrade to V8 format” as shown: 
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The FDOT2004 CADD software provides a subdirectory that contains support files for MicroStation V7 
production. These files are located in the following subdirectories below the main FDOT2004 directory: 
 
 
 
 
 
 
 
The FDOT2002_V8 workspace sets environment variables that point to these V7 subdirectories that 
contain R/W support files for working with metric units. 
 
 

o GEOPAK/databases - rwsm02.ddb, Design and Computation Manager database for V7 
that contains both English and Metric elements. The user should check that this database 
is selected. If not, select “File>Open” from D&CM dialog. 

 

 
 
o Standards/cells – rwmet.cel and row.cel, V7cell library files for English and Metric 

design files respectively. 
 

o Standards/seed – rwmet2dv7.dgn, V7 seed file format. 
 
o Standards/symb – rwlineng.rsc and rwln500m.rsc, V7 custom line style formats for 

English and Metric line styles respectively.  The Metric custom line styles are created at a 
ratio of 1:500 and scale settings should be set accordingly.  All Metric custom line styles 
will contain [M] text appended to each line style name. To assure that the metric lines 
style resource file has been loaded select from   MicroStation Main Menu “Edit>Line 
Styles> Custom: 
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The working units of the design file should be set to Metric by selecting from the MicroStation Main 
Menu “Settings>Design file…” and if needed changing the Master Unit and Sub Unit as shown: 

 

 
 

The FDOT2002_V8 workspace will automatically set the FDOT Menu to the FDOT2002 standards. To set 
the FDOT Menu to Right of Way select from the menu “Standard V7> Configuration” and select “Standard 
Plus Right-of-Way Menu”.  
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MicroStation will restart and the menu items will be as shown: 
 

 
 
 
The FDOT2002_V8 workspace will also use a MicroStation V8 design file level library (v7_levels.dgnlib) 
that contains legacy level names from FDOT V7 format. These are the 1 – 63 levels previously used for 
FDOT CADD symbology.  When R/W MicroStation V7 files are converted to V8 format, as suggested 
above for Metric revisions, the original level settings used for each element will be brought forward and 
can be used in conjunction with the D&CM, V8 Level Display and V8 Level Manager as shown below: 
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All of the above items should be checked by the user prior to working on Metric design files in 
MicroStation V8.  It is also recommended that the entire project be upgraded to V8 format even if the 
revision(s) will only impact a portion of the project.  Once the project has been upgraded to V8 it should 
not be converted back to V7 format as this could cause some data lose.  Coordination with other 
departments that may need access to these files in original V7 format should be considered prior to 
upgrading V7 files to V8 format. 
 

9.8 Converting R/W Design Files to MicroStation V8 
 
Prior to converting Right of Way Mapping project/design files to V8 format the user should consider the 
following: 
 
 

o It is important that all design files that are to be converted should adhere to the CADD 
Standards the project was created in. 
 

o The design files must be QC compliant to FDOT CADD Standards (file names and graphical 
symbology). 
 

o The design files must be free of errors related to file integrity. This can be done with tools 
such as Axiom’s FileFixer. 
 

o If an entire project is to be converted to V8, all disciplines working on that project must be 
migrated at the same time (No exceptions). 
 

o If the design file to be converted is a V7 design file use the FDOT script files provided. If the 
design file is to convert format only, simply open in MicroStation V8 and accept the option to 
convert to V8 file format. 
 

o After the conversion convert any support file such as Geopak input files. Check Global Origin, 
Working Units, Level Names and Reference Attachments. 
 

o IMPORTANT: Always work on a COPY of files to be converted. 
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To convert V7 design files to MicroStation V8 the following procedure is recommended: 
 
A R/W conversion script file is provided with the FDOT2008 CADD software and is located in the following 
directory: 
 

C:\FDOT2008\RESOUCES\data\rwv7toMR3.csv 
C:\FDOT2008\RESOUCES\data\V8MR3toXM.csv 
 
This file is an Excel spreadsheet and contains required column data for converting V7 design files to 
V8 Right of Way Mapping CADD Standards. 
  
During the conversion process this file is used to search for existing elements symbologies within the 
V7 design file and selects those elements that match the description within the table and converts 
these to V8 symbology elements in the output design file. 

 

 
 
MicroStation V8 provides several methods for converting design files to V8. Only one method is described 
here and is the recommended procedure for R/W CADD users. This procedure uses the MicroStation:  
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9.8.1 Batch Converter 
 

The Batch Converter utility can convert a single design file or multiple files 
across different directories and apply different conversion format types to 
selected design files.  For full instructions on the use of this utility the user 
should refer to MicroStation Help files. 
 
To begin the conversion process on a single V7 design file open the Batch 
Converter by selecting from the Main Menu Utility>Batch Converter: 
 

 
 

o Default Output Format – Set the output format to V8 
 

o Default Destination – Set the directory location for the output file. The small magnifying 
glass can be selected to browse to the desired location. It should be noted that the Batch 
Converter program will not overwrite an existing design file in the output directory with the 
same name. However the program does not prompt the user that a file already exists with 
the same name but will state in the conversion dialog that the file is up to date. 

 
o Select Edit >V8 Options – Sets the conversion file name (rwv7toMR3.csv and what 

element symbology types to convert.)  
 
 

In the Save V8 Options dialog box set the CSV file name to rwv7toMR3.csv 
or by selecting the magnifying glass the user can browse to the desired 
location. Make sure each element symbology type to be converted is selected. 
Note that the Apply Font Mapping is grayed out, as this conversion file 
contains no data for converting font types.  Select the OK button when 
complete. 
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Select the Add Files or Directories to Convert button to open the directory and file selection dialog. As 
stated, multiple files or directories can be added to the file list as needed. 
 

 
 
After all files to be converted are added to the list, select the Process Batch Convert Job button to 
begin processing. 
 

 
 
The Files to Convert dialog displays the file path and name of the file to be converted, the 
destination file name and path along with the Status: Pending or Up to Date.  As stated, if the Status 
is up to date a file with the same name already exists at that directory location and the converter will 
not processes that file name. 

 
 
Select the Convert button and all files will be converted to V8 format with standard R/W V7 elements 
converted to standard FDOT2008 R/W V8 symbologies. After conversion, the above dialog should 
appear as shown below, with the Convert button changed to Done and the Status column changed to 
Converted.  
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